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ABSTRACT

Heavy metals, such as lead, mercury, and selenium, have been epidemiologically linked with a risk of ALS, but a molecular
mechanism proving the connection has not been shown. A screen of putative developmental neurotoxins demonstrated
that heavy metals (lead, mercury, and tin) trigger accumulation of TDP-43 into nuclear granules with concomitant loss of
diffuse nuclear TDP-43. Lead (Pb) and methyl mercury (MeHg) disrupt the homeostasis of TDP-43 in neurons, resulting in
increased levels of transcript and increased splicing activity of TDP-43. TDP-43 homeostasis is tightly regulated, and
positively or negatively altering its splicing-suppressive activity has been shown to be deleterious to neurons. These
changes are associated with the liquid-liquid phase separation of TDP-43 into nuclear bodies. We show that lead directly
facilitates phase separation of TDP-43 in a dose-dependent manner in vitro, possibly explaining the means by which lead
treatment results in neuronal nuclear granules. Metal toxicants also triggered the accumulation of insoluble TDP-43 in
cultured cells and in the cortices of exposed mice. These results provide novel evidence of a direct mechanistic link
between heavy metals, which are a commonly cited environmental risk of ALS, and molecular changes in TDP-43, the
primary pathological protein accumulating in ALS.
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Amyotrophic lateral sclerosis (ALS) stems from the loss of Neumann et al., 2006). TDP-43 inclusions also present as second-
descending motor neurons resulting in muscle degeneration ary pathology in varying degrees in a number of neurodegenera-
and eventually death. In the large majority of ALS cases, motor tive diseases, including in frontotemporal dementia (Murray
neurons are observed to accumulate pathologic insoluble cyto- et al, 2011), Alzheimer’s disease (Uryu et al, 2008), and
plasmic and nuclear inclusions of TDP-43 (Arai et al., 2006; Parkinson’s disease (Nakashima-Yasuda et al., 2007). TDP-43 is
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an RNA-binding protein (RBP) that exhibits both nuclear and cy-
toplasmic functions. It is predominantly localized to the nu-
cleus under basal conditions, where it is involved in RNA
splicing, as well as a multitude of other RNA metabolic func-
tions (Ratti and Buratti, 2016). The presence of cytoplasmic and
intranuclear inclusions may therefore produce neuronal toxic-
ity through a gain of function or through disruption of physio-
logical functions of TDP-43 in the nucleus, from which it is
depleted. The causes of ALS are incompletely understood.
While mutations in TDP-43 are associated with heritable ALS
(Rutherford et al., 2008; Sreedharan et al., 2008), the 90%-95% of
ALS cases that occur without a family history of the disease all
demonstrate TDP-43 pathology post-mortem.

Environmental risk factors likely play an important role in
ALS (Oskarsson et al., 2015). Exposure to heavy metals (including
lead, mercury, and selenium) (Beghi et al., 2006; Trojsi et al.,
2013) increase odds ratios of developing ALS. Increased risk of
ALS has been associated with increasing age, with gender,
smoking, and diet (de Jong et al., 2012; Morozova et al., 2008;
Wang et al., 2011), with service in the military (Weisskopf et al.,
2005, 2015), and with exposure to toxins such as organophos-
phates in agricultural herbicides and pesticides (Das et al., 2012).
A ~100x fold increase in risk of a complex of disorders consist-
ing Parkinsonism, dementia, and ALS has been connected to the
consumption of the amino acid p-methylamino-i-alanine
(BMAA) (Munoz-Saez et al., 2015). Metals have also been associ-
ated with increased risk of other neurodegenerative disease
such as Parkinson disease, Alzheimer’s disease, and Wilson'’s
disease (Bjorklund et al., 2018; Squitti et al., 2018). Airborne expo-
sure to aromatic agonists of the aryl hydrocarbon receptor
(AHR) have been linked to ALS (Ruder et al., 2014; Malek et al.,
2015). We recently demonstrated that polycyclic aromatic
hydrocarbons (PAHs) and other agonists of the AHR, including
dioxins and planar polychlorinated biphenyls (PCBs), increases
accumulation of TDP-43 in motor neuron differentiated iPSCs
and in murine brain (Ash et al., 2017). The link between AHR
activators and TDP-43 accumulation raises the possibility that
other environmental risk factors linked to ALS might contribute
to TDP-43 pathology.

Due to time and resource constraints, it is challenging to test
the large number of environmental compounds for their poten-
tial to cause neurodevelopmental and/or neurodegenerative
changes using traditional in vivo methods. As such, the need to
create a screening battery to prioritize compounds for further
testing is well recognized (Aschner et al., 2017; Bal-Price et al.,
2012; Crofton et al., 2012; Fritsche et al., 2018; Smirnova et al.,
2014). In this study, we assayed 91 putative neurodevelopmen-
tal toxins (National Toxicology Program high-throughput screen
NeuroTox 91 Plate-Number: 4001204495) (Behl et al., 2018)
for their ability to trigger aggregation of TDP-43 in stably
transfected rat PC12 cells. We observe that four toxicants, lead
(II) acetate trihydrate, methyl mercuric (II) chloride, bis(tributyl-
tin)oxide, and colchicine, produce a larger fraction of PC12 cells
with TDP-43 aggregates. As lead and mercury have been linked
epidemiologically with increased risk of ALS, we further investi-
gated the consequences of exposure on the biochemistry and
function of TDP-43. Lead and methyl mercury trigger formation
of nuclear Tdp-43 inclusions in primary neurons. Exposure to
lead and methyl mercury results in accumulation of insoluble
Tdp-43 and dysregulation of its function in alternative splicing.
Lead also promotes the liquid-liquid phase separation (LLPS) of
TDP-43 in vitro. These important findings connect exposure to
the heavy metals lead and mercury to the key pathological and
molecular aberrations that occur in ALS, namely the

aggregation of TDP-43 and its perturbed RNA metabolic func-
tions. Furthermore, it demonstrates how a battery of screening
platforms, including the PC12 cell line, might be used as a
means to identify environmental neurotoxins that warrant fur-
ther analysis in vivo.

MATERIALS AND METHODS

PC12 cell culture. Frozen stocks of rat PC12 cells that were stably
transfected with Tet-off-inducible wild-type TDP-43::GFP (for
details, see Boyd et al, 2014) were thawed and grown in
collagen-coated flasks (Thermo Fisher, 132708) in DMEM (4.5g/
1 glucose, 1-glutamine, and sodium pyruvate; Corning 10-013-
CV) with 10% horse serum (Gibco, 26050088), 5% Tet-free FBS
(Atlanta Bio, S10350H), 10 ug/ml Pen/Strep (Gibco, 15140122), 0.1
mg/ml Hygromycin B (Gibco, 10687010), 0.1 mg/ml geneticin
(Gibco, 10131027), and 1pg/ml doxycycline for 72h using stan-
dard cell culture techniques. TDP-43:: GFP expression was in-
duced by aspirating the flask and replacing with induction
media lacking doxycycline for 72h. For each screening experi-
ment, the induced PC12 cells were plated into 5 collagen-coated
96-well plates (Corning, 354407) (3 x 10* cells/well) in 100l in-
duction media. No cells were plated in wells on the first and the
last row of plates. As negative controls, uninduced cells were
plated in wells B2, B3, C2, and C3 of plate 1 in each experiment.
After overnight incubation, the cells were treated with
compounds.

NTP HTS NeuroTox compound screening. The assay screened 91
compounds received from NIEHS (NTP HTS NeuroTox 91 Plate-
Number: 4001204495) (Behl et al., 2018) in TDP-43:: GFP express-
ing PC12 cells. The compounds were suspended at ~20 pM in
DMSO (except compounds C7 and C10) and were provided in
0.75ml alphanumeric screwcap tubes in 96-vial plate rack
thereby blinding the researcher to the compound. Induced PC12
cells were treated for 18-20h with compounds in four doses:
100, 25, 6.25, and 1.56 uM in quadruplicate. Cells treated with
compounds C7 and C10 received 6.25, 1.56, 0.39, and 0.1 uM
treatments in quadruplicate. In each experiment consisting of
five 96-well plates, 18 compounds were assayed. In each plate,
triplicate wells were treated with 0.125% DMSO (vehicle) and
15 pM sodium arsenite (with 0.125% DMSO) as negative and pos-
itive controls of TDP-43:: GFP aggregation and to permit normal-
ization across plates.

PC12 image acquisition and statistical analysis. Following treat-
ment, the plates were washed twice with phosphate-buffered
saline (PBS) before fixing with 4% PFA in PBS for 20 min at 4°C.
The fixed cells were washed with cold PBS, counterstained with
0.5 pg/ml DAPI in PBS and stored at 4°C until imaging (less than
48h). The 96-well plates were imaged on an IN Cell Analyzer
2000 (GE Healthcare) by 50 ms acquisition in the DAPI and GFP
channels from 9 preselected random fields in each well. Images
were analyzed using IN Cell Workstation software (GE
Healthcare). Cells were segmented using an algorithm wherein
DAPI-stained nuclei were defined with a minimal area of 22 ym?
and a periphery of 5um. Cell viability under compound treat-
ment was quantified by nuclei count. Details of image segmen-
tation analysis of TDP-43:: GFP diffuse and punctate phenotypes
was previously described in Boyd et al. (2014). The proportion of
cells with diffuse and/or punctate TDP-43:: GFP was quantified
giving 4 feature outputs: (1) cell viability; (2) % diffuse cells with
diffuse TDP-43:: GFP; (3) % punctate TDP-43: GFP/cell; and



(4) ratio of “% diffuse TDP-43:: GFP”:“% punctate TDP-43:: GFP”.
Mean * 25D cell count of the 9 imaging fields per well were cal-
culated and outliers excluded. Outliers were observed in 20%-—
50% of the wells across the experiments; in particular, field no. 3
(located in the well where aspiration occurred) was a frequent
outlier. Hence, field no. 3 was excluded from all data sets.
Within each experiment, the means of each feature output of
the wells treated with 15pM sodium arsenite (with 0.125%
DMSO), ie, column 12 of plates 2, 3, 4, and 5, were normalized to
those of plate 1. The individual well values of each feature out-
put on a plate were then transformed against the normalized
mean feature outputs of the 15uM arsenite-treated wells on
that plate to account for interplate differences. Statistical differ-
ences were calculated from normalized values by 1-way ANOVA
(with Dunnett’s post hoc comparison of treatment groups to
DMSO vehicle control).

Immunofluorescent imaging of Tdp-43 in primary neuronal culture.
Primary hippocampal neurons were isolated from PO CD1 pups
and cultured in neurobasal medium (Gibco, 21103049) supple-
mented with 2% B-27 (Gibco, 17504044), 200puM 1-glutamine
(Gibco, 25030081), and PenStrep. Animals were housed and
treated according to Boston University School of Medicine
IACUC-approved protocols. Hippocampal neurons were plated
at 1 x 10° cells/well onto nitric acid-washed, poly-p-Lysine-
coated 12mm coverslips in 24 well plates then maintained
14 days in vitro (DIV) before treating in quadruplicate for 6h
with lead (II) acetate trihydrate (at 0.174, 0.521, 1.56, and 4.69
uM; Sigma) or methyl mercuric (II) chloride (at 0.058, 0.174,
0.521, and 1.56 uM). Previous studies of neuronal death have
used lead treatment in the range of 0.2-2 M and methyl mer-
cury in the range of 10nM-1uM (Engstrom et al., 2015; Fujimura
and Usuki, 2012). After treatment, hippocampal neurons were
then washed in PBS, fixed in 4% PFA in PBS, permeabilized with
PBS w/0.5% Tween 20, blocked with 10% normal donkey serum
(Sigma) in PBS, and immunostained overnight with 1:400 (rab-
bit) anti-Tdp-43 (ProteinTech; 12983-1-AP) and 1:200 (chicken)
anti-Map2 (Aves labs; MAP). Images (4 independent experiments
per treatment, 10 images per experimental coverslip, ~3 neu-
rons per ROI = approx. 120 neurons per treatment group) were
acquired at 63x as z-stacks on a Zeiss AxioObserver Al with
equal exposures for all treatment groups, deconvolved then
compressed into maximum intensity projection images (Zen,
Zeiss). Tdp-43 granules were detected in Bitplane (Imaris) using
a masking algorithm that identifies neuronal cells (by Map2),
neuronal nuclei (based on size, sphericity, and an intensity
threshold for Tdp-43 and DAPI signal within Map?2 cells) and nu-
clear Tdp-43 granules (based on an intensity threshold for Tdp-
43 and an estimated diameter of 0.45 pm). Outliers were re-
moved in GraphPad Prism by ROUT (Q =0.1%). Statistical analy-
ses were performed as described above.

Splicing of sortilinl exon 17b as an assay of Tdp-43 function.
Primary CD1 cortical neurons were plated at 2 x 10° cells/well
onto PDL-coated 6 well plates and maintained in culture until
commencing treatment on DIV7. These neurons were treated
(n=6) every 48h with 0.521 or 1.56 uM lead (II) acetate trihy-
drate. At DIV14, total RNA was extracted by RNeasy minikit
(Qiagen), quantified and reverse transcribed by High-Capacity
cDNA Reverse Transcription Kit (Thermo) before qPCR analysis
using SYBR Green master mix (Bio-Rad). Relative levels of total
sortilin 1 (Sortl), Tardbp, and Actb were quantified and normal-
ized to the means of untreated group. Alternate splicing of Sort1l
was assessed as reported previously (Prudencio et al., 2012)
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using qPCR primer sets to quantify the relative levels of Sortlwr
transcripts (with exclusion of exon 17b) and Sortl, 7, tran-
scripts. Primer sets are reported in Supplementary Table 2.

Liquid-liquid phase separation of TDP-43. Recombinant TDP-43 was
produced as described previously (Carlomagno et al.,, 2014).
Briefly, human TDP-43 was produced in bacteria with expres-
sion induced with IPTG at 16°C. Pelleted bacteria were lysed and
clarified, and proteins were precipitated in 15% ammonium sul-
fate solution. Precipitated proteins were resuspended, dialyzed,
and clarified before confirming purity by SDS-PAGE/Coomassie.
Phase separation of 5uM TDP-43 was performed in 10 mM
HEPES, pH 7.4, 100mM NaCl, 20ng/ul total murine brain RNA
and induced with addition of 1% polyethylene glycol (PEG)-8000.
0.0025% of 1 micron Polybead® Carboxylate inert polystyrene
microspheres (Polysciences) were added to LLPS reactions to aid
sample focusing. Reactions were performed at 24°C for 2h in
triplicate reactions with 10, 20, 40, 80, 160, 320, and 640 uM lead
(IT) acetate trihydrate, nickel (II) sulfate, zinc (II) sulfate, or cobalt
(IT) chloride. Droplet formation was detected by differential in-
terference contrast at 63x in 3l reactions in coverslipped slide
microchambers created from SecureSeal spacers (Grace Bio-
Labs). TDP-43 droplets were counted in ImageJ(Fiji) (Schindelin
et al., 2012): (1) Plugins>Filters>Enhance local contrast; (2)
Process>Enhance contrast: normalize histogram; (3)
Image>Type > 8-bit, Image>Color>Edit LUT: ICA, Image>
Type>RGB, Image>Type >8-bit; (4) Plugins>Filters>Enhance
local contrast; (5) Process>Filters>Gaussian blur: 7; (6)
Image>Adjust>Threshold: Triangle method; and (7) Analyze>
Analyze particles. Droplet count was quantified as percentage
of image area covered by droplets.

TDP-43:: GFP solubility in lead-exposed PC12 cells. PC12 cells were
cultured and induced as described above. For TDP-43 solubility
and expression studies, 5 x 10° induced PC12 cells/well were
plated to collagen-coated 6-well plates (Gibco, A11428-01). The
following day (DIV1), cells were treated in triplicate with lead (II)
acetate trihydrate at concentrations of 0.174, 0.521, 1.56, and
4.69 pM by adding stock solutions directly to the 2ml culture
media of each well. The treatment was reapplied on DIV3 and
DIV5 by aspirating, replacing induction media (containing no
doxycycline), and adding compound. Cells were harvested on
DIV6 by washing twice with PBS, scraping the cells into PBS, pel-
leting (800 rcf for 2 min) then lysed by sonication in RIPA buffer.
Sample concentrations were determined by BCA assay. Blotting
of total lysates and RIPA solubility of TDP-43:: GFP was per-
formed as described previously (Ash et al., 2017). Blots were in-
cubated with the following antibodies: 1:1000 anti-phospho-
S409/410 TDP-43 (a gift from Leonard Petrucelli, Mayo Clinic,
Rb3655), 1:2000 anti-GFP (Sigma; G1544), 1:2000 anti-TDP-43
(ProteinTech; 12892-1-AP); and 1:10000 anti-Actin (Millipore;
MAB1501). Blots were imaged using HRP-conjugated secondary
antibodies (Jackson) activated with Pierce ECL chemilumines-
cent substrates (Thermo Fisher) and a ChemiDoc XRS+ Imager
(BioRad). Band densitometries were assessed using Image Lab
Software (Bio-Rad) and GraphPad Prism was used to perform
ANOVA statistical analyses with Dunnett’s multiple comparison
test against untreated controls.

In vivo methyl mercury exposure and analysis of murine cortical tissue.
Nine-month-old, male BALB/c mice were purchased from
Envigo Laboratories (Indianapolis, Indiana) and individually
housed in a temperature- and humidity-controlled AAALAC-
accredited animal facility. All procedures were approved by the
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Auburn University Institutional Animal Care and Use
Committee. Upon arrival, mice were exposed to 0 or 5ppm
MeHg as methyl mercuric (II) chloride dissolved in drinking wa-
ter. Mice had free access to water and were maintained at ap-
proximately 25 (+1) g body mass via daily feedings of 3.0 (x1) g
chow. Mice were food restricted to motivate responding in be-
havioral experiments and to maintain healthy body mass (for
details, see Shen et al., 2016). After 42 weeks of exposure (at ap-
proximately 18 months of age), mice were euthanized via decap-
itation and the whole brain was extracted, frozen, and stored
for later analysis. A total of ~60 mg of frozen cortical tissue was
lysed by bead mill (Thermo) homogenization in 1ml Qiazol re-
agent (Qiagen) then the RNA was extracted following the Lipid
tissue RNeasy minikit protocol (Qiagen). gPCR on reverse-tran-
scribed total RNA was performed as described above. A total of
~100 mg of frozen cortical tissue was lysed by bead mill
(Thermo) homogenization in Tris-EDTA buffer (10 mM Tris pHS;
1mM EDTA; 1mM PMSF; 1x HALT PIC, and PhosSTOP [Roche]).
Sample concentrations were determined by BCA assay.
Solubility of murine Tdp-43 was assayed as described previ-
ously (Neumann et al., 2006). Briefly, equal amounts of cortical
lysates were sequentially extracted by ultracentrifugation in
buffers containing increasing detergent strengths. The final pel-
let is the product of insolubility in 1% sarkosyl/500 mM NacCl
centrifuged at 180 000 rcf for 30 min then re-suspended in 8 M
urea buffer. Total TE lysates, sarkosyl soluble, and sarkosyl in-
soluble fractions were then blotted as described above and
immunolabelled using 1:2000 anti-TDP-43 (ProteinTech; 12892-
1-AP) and 1:10 000 anti-Actin (Millipore; MAB1501). Band densi-
tometries were assessed using Image Lab Software (BioRad) and
unpaired two-tailed t tests performed in GraphPad Prism.

RESULTS

Screening for Neurotoxicants in an Inducible TDP-43::GFP Cell Line

We previously generated a rat PC12 cell line that stably
expresses Tet-off-inducible wild-type human TDP-43::GFP that
forms inclusions of TDP-43:: GFP upon treatment with sodium
arsenite (Supplementary Figure 2) (Boyd et al., 2014). Using this
cell line, the 91 compound “NeuroTox” plate (Behl et al., 2018)
was screened by a blinded researcher to identify putative neuro-
toxins that result in aggregation of TDP-43, the loss of diffuse
nuclear TDP-43, and cell death. A number of compounds were
cytotoxic leading to dose-dependent cell death, other toxicants
(often at the highest concentration) triggered statistically signif-
icant but biologically small effects to the TDP-43 (chemical list
and screening results in Supplementary Table 1 and Figs. 1A-E).
Four toxicants robustly increased the percentage of cells with
TDP-43:: GFP aggregates or the ratio of cells with TDP-43:: GFP
aggregates/diffuse TDP-43:: GFP (Figure 1A). Lead (II) acetate tri-
hydrate (Figure 1B, compound F2) caused TDP-43:: GFP to aggre-
gate (DMSO, x = 15.3%, +2.12 SEM, of cells; lead (II) acetate
trihydrate maximal affect at 25uM, x = 38.8%, +4.33 SEM,
p <.0001) without substantially affecting the percentage of cells
with diffuse TDP-43:: GFP or causing significant cell death.
Methyl mercuric (II) chloride treatment caused significant ag-
gregation of TDP-43:: GFP with concurrent reduction in the per-
centage of cells with diffuse TDP-43:: GFP (DMSO aggregates/
diffuse ratio, X = 28.9, =3.41 SEM; methyl mercuric (II) chloride
maximal affect at 6.25 uM, X = 126, *23.4 SEM, p <.0001).
Treatment with methyl mercuric (II) chloride at the higher
doses of 25 and 100 uM caused substantial cell death (p <.05 vs
cell count with DMSO). Unknown to the researcher who

completed the screen, methyl mercuric (II) chloride was placed
on the NeuroTox plate twice (Figure 1B, compounds F5 and H5)
and generated similar results, indicating the accuracy of the
PC12 stable cell line as a means to observe neurotoxin effects on
TDP-43. Bis(tributyltin)oxide (Figure 1B, compound C10) treat-
ment similarly increased the ratio of cells with aggregates ver-
sus diffuse TDP-43:: GFP (maximal affect at 1.56 M, x = 206,
+53.0 SEM, p <.0001) with significant cell death triggered by the
highest doses of 1.56 and 6.25 pM. Colchicine (Figure 1B, com-
pound D8) increased the levels of both aggregated and diffuse
TDP-43:: GFP at all concentrations without generating cytotoxic-
ity. While a number of the putative developmental neurotoxins
screened had some affect on cell survival and TDP-43 distribu-
tion, the identification that lead-, mercury- and tin-based com-
pounds induce aggressive aggregation of TDP-43 is particularly
interesting as exposure to heavy metal compounds have been
linked with increased risk of ALS (Beghi et al., 2006).

Lead and Methyl Mercury Trigger Formation of Endogenous Tdp-43
Inclusions

To assess whether heavy metal compounds affect endogenous
TDP-43 in neuronal cells, we cultured primary hippocampal
neurons from PO CD1 pups to better reflect the biology of the
central nervous system. Previous studies from our laboratory
show that hippocampal neurons reflect the biology of ALS. They
exhibit abundant TDP-43 in the processes, dendritic TDP-43
granules whose size and movement respond to mutations in
TDP-43, develop strong cytoplasmic aggregates of TDP-43 upon
exposure to stress, and have glutamate receptors (Liu-
Yesucevitz et al., 2014). Importantly, TDP-43 pathology occurs in
the hippocampus and neocortex in ALS and some ALS patients
develop overt cognitive decline (Brettschneider et al., 2013;
Goldstein and Abrahams, 2013). Neurons were grown for 14 days
then exposed for 6h to lead (II) acetate trihydrate (at 0.174,
0.521, 1.56, and 4.69 uM) or methyl mercuric (II) chloride (at
0.058, 0.174, 0.521, and 1.56 uM). Both compounds caused endog-
enous Tdp-43 to form nuclear granules, which were detected by
immunofluorescence and quantified using a masking algorithm
(Figure 2A, Supplementary Figure 3A). Exposure to lead (II) ace-
tate trihydrate triggered formation of nuclear Tdp-43 inclusions
in a biphasic manner (Figure 2B). A total of 0.174 pM lead pro-
duced ~4x fold more granules per neuronal nuclei compared
with the vehicle, 0.571 uM lead produced a ~2.5x fold increase,
1.56 pM lead produced a ~5x fold increase, and 4.69 pM lead
produced a ~3.5x fold increase (DMSO granules/nuclei, X = 0.57,
+0.19 SEM; lead 0.174 uM, x = 2.52, =0.63 SEM, p < .01; lead 0.521
uM, % = 1.46, =0.27 SEM, ns; lead 1.56 uM, & = 3.00, +0.54 SEM,
p<.001; lead 4.69 uM, X = 2.00, +=0.46 SEM, p <.05). These data
suggest that lead compounds employ different molecular path-
ways to induce Tdp-43 accumulation at different concentra-
tions. Methyl mercuric (II) chloride triggered formation of
nuclear Tdp-43 inclusions in a dose-dependent fashion, gaining
significance at the 0.521 M dose with ~4x fold granules per
neuronal nuclei compared with the vehicle control (Figure 2B;
DMSO granules/nuclei, x = 0.57, £0.19 SEM, mercury, X = 2.43,
+0.43 SEM, p <.01). In Supplementary Figure 3B, the frequency
with which neurons develop a set number of granules per nuclei
is plotted. At those doses of both lead and methyl mercury that
significantly increase the mean number of inclusions per neu-
ron, both the frequency in the number of neurons with nuclear
inclusions and the number of inclusions in those nuclei
increases. The discovery that lead and methyl mercury cause
formation of Tdp-43 inclusions in neurons is hugely important
because it is the first demonstration of a putative molecular
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Figure 1. A screen of neurotoxins in inducible stably expressing cells reveals heavy metals trigger formation of nuclear TDP-43:: GFP inclusions. PC12 cells expressing
TDP-43:: GFP were screened against developmental neurotoxins in the NTP HTS NeuroTox 91 Plate (Chemical list, Supplementary Table 1). High-content imaging was
used to quantify cell count, number of cells with diffuse TDP-43:: GFP and number of cells with nuclear TDP-43:: GFP inclusions (full screening results in
Supplementary Figs. 1A-E). A, Four compounds were found to induce formation of TDP-43 inclusions: lead (II) acetate trihydrate (compound ID: F2), methyl mercuric
(I1) chloride (F5, HS), colchicine (D8) (concentrations: 1.56, 6.25, 25, and 100 uM) and Bis(tributyltin)oxide (C10) (concentrations: 0.1, 0.39, 1.56, and 6.25 uM). N =4; mean
+SEM; ANOVA w/Dunnett’s multiple comparison test, *p <.05, *p < .01, **p <.01. B, Representative images of merged GFP and DAPI signals show cells with diffuse nu-
clear TDP-43:: GFP upon DMSO (vehicle control) treatment and nuclear TDP-43:: GFP inclusions upon exposure to lead (II) acetate trihydrate, methyl mercuric (II) chlo-
ride, bis(tributyltin)oxide, and colchicine (at concentrations shown). Representative images of positive control (2uM arsenite), uninduced PC12 cells, and different

compound doses are shown in Supplementary Figure 2.

mechanism mediating the linkage between exposure to heavy
metals and ALS.

Lead Treatment of Neurons Inhibits Tdp-43 Splicing of Sortilin 1
Exon 17b

Sortillin 1 (Sortl) is a known target of alternative splicing medi-
ated by TDP-43, with knockdown or deletion of TDP-43 increas-
ing the inclusion of exon 17b (Afroz et al., 2017; Polymenidou
et al., 2011; Prudencio et al.,, 2012). We hypothesized that lead-
induced perturbation of nuclear Tdp-43 would alter its function
resulting in dysregulation of splicing. Primary cortical neurons
were treated every 48h for 7 days with 0.521 or 1.56 pM lead (II)

acetate trihydrate (Pb). QPCR observation of the ratio of sortilin 1
transcripts containing exon 17b (Sortl, gx;7p) over sortilin 1 wild-
type transcripts (Sortlwr; excluding Ex17b) shows that lead sig-
nificantly reduces inclusion of exon 17b (Figure 2C; untreated
ratio, X = 1.00, +=0.065 SEM, 1.56 uM Pb, x = 0.793, =0.024 SEM,
p<.05). Lead treatment also produced a significant increase in
the transcript levels of Tdp-43 (Tardbp; Figure 2D; untreated, X =
1.00, =0.049 SEM, 1.56 uM Pb, X = 1.22, +0.020 SEM, p < .05) and
in the total levels of Sortl transcript (Supplementary Figure 4;
untreated, X = 1.00, +0.045 SEM, 1.56 uM Pb, X = 1.17, +0.038
SEM, p <.05). While the effect at the 0.521 pM dose was not sig-
nificant, the trend observed was similar to that with the higher
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Figure 2. Exposure to lead and methyl mercury triggers formation of neuronal nuclear inclusions of endogenous Tdp-43. A, Primary hippocampal neurons (DIV14) ex-
posed for 6h to lead (II) acetate trihydrate and methyl mercuric (II) chloride develop nuclear inclusions of endogenous Tdp-43. Neurons were immunolabelled with
antibodies to MAP2 (magenta) and Tdp-43 (green) and nuclei were counterstained with DAPI (blue). Shown are representative images of neurons treated with 2 uM so-
dium arsenite, 4.69 uM lead (II) acetate trihydrate, and 1.56 uM methyl mercuric (II) chloride. Secondary only controls show no immunolabel (Supplementary Figure 3).
A masking algorithm (Imaris, Bitplane) was used to detect and quantify inclusions per neuronal nuclear. B, Lead (II) acetate trihydrate concentrations: 0.174, 0.521, 1.56,
and 4.69 pM; methyl mercuric (II) chloride concentrations: 0.058, 0.174, 0.521, and 1.56 uM. N=4; mean *= SEM; ANOVA w/Dunnett’s multiple comparison test versus
DMSO control, *p < 0.05, **p < 0.01, **p < 0.01. C, Lead at 1.56 uM effects the alternative splicing function of Tdp-43 leading to reduced ratio of inclusion of Sortl exon 17b
compared with wild-type Sort1 transcripts. This negatively correlates (Supplementary Figure 4E; slope = —0.65 = 0.21, R? = 0.39, p=.0074) with an increase in transcript
levels of Tdp-43 (Tardbp) (D) upon lead treatment. N = 6; mean +SEM; ANOVA w/Dunnett’s multiple comparison test, *p < .05, *p <.01.

dose. The decrease in inclusion of Sortl exon 17b suggests that
the increased nuclear accumulation of total Tdp-43 that is asso-
ciated with exposure to Pb increases splicing activity mediated
by Tdp-43. Multiple studies have shown that both increases and
decreases in Tdp-43 levels are toxic (Tsao et al., 2012).

Lead Accelerates Phase Separation of TDP-43

RBPs regulate many aspects of RNA metabolism through RNA
binding via the RNA binding domains and through reversible
self-assembly and LLPS (formation of liquid droplets) via intrin-
sically disordered regions (IDRs). LLPS has been modeled for
multiple RBPs in vitro, including TDP-43, using recombinant pu-
rified proteins (Wang et al., 2018). Protein, salt, and crowding re-
agent concentrations modulate the kinetics of TDP-43 LLPS
(Wang et al., 2018). Phase separation of 5puM TDP-43 did not oc-
cur over a 2h experiment using 100 mM NaCl, 1% PEG (a crowd-
ing reagent), and 20ng/ul total murine brain RNA. However,
addition of lead (II) acetate trihydrate to the reaction mix pro-
moted TDP-43 LLPS in a dose-dependent manner (Figure 3A;
mask in Supplementary Figure 5A) with an ECsy of 160uM
(Figure 3B; 95% CI 150.5 to 169.4, R? = 0.887; 5 images each from

3 independent experiments). Interestingly, at low concentra-
tions of lead, TDP-43 formed small single droplets (arrows in
Figure 3A), while at higher concentrations of lead, TDP-43 phase
separates into large amorphous consolidates (asterisk in
Figure 3A). Neither nickel (II) sulfate nor cobalt (II) chloride in-
duced TDP-43 LLPS at the highest concentration. However, zinc
(I) sulfate triggered robust phase separation in a dose-depen-
dent manner with a lower ECsq of 79.3 uM (Supplementary Figs.
5B and 5C).

Lead Exposure Results in Accumulation of Insoluble TDP-43

To address whether lead produces a similar change in solubility
of TDP-43 in cells, PC12 cells were induced to express TDP-43::
GFP and then exposed to lead (II) acetate trihydrate for 6 days in
triplicate at concentrations of 0.174, 0.521, 1.56, and 4.69 uM.
The solubility of TDP-43:: GFP in RIPA buffer was then assessed
by ultracentrifugation and immunoblotting of the RIPA insolu-
ble (Figure 3C), RIPA soluble (Figure 3D), and total RIPA lysate
(Figure 3E). At the lower concentrations of lead (0.174 and 0.521
uM), the total levels of TDP-43:: GFP increased significantly
(Figs. 3E and 3F; untreated, X = 1.00, =0.073 SEM, 0.174 uM Pb,
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Figure 3. Lead triggers phase separation of TDP-43 and decreases its solubility. A, Purified TDP-43 LLPS in vitro is facilitated by lead (II) acetate trihydrate (Pb) in a
dose-dependent manner. Representative 63x DIC images. Arrows: examples of single TDP-43 droplets. Asterisk: examples of amorphous TDP-43 consolidates.
Arrowheads: high-contrast, inert 1 micron polystyrene microspheres added to aid sample focusing. Scale bar = 10 um. B, LLPS was quantified using an Image]J algorithm
as percentage of ROI covered by droplets. Points at mean, with error bars at SEM, were fit by nonlinear regression analysis (line) and the LogEC50 calculated as 160 uM
(dotted line). Induced PC12 cells accumulate insoluble TDP-43:: GFP upon treatment with lead (Pb). Immunoblots of RIPA insoluble (C), RIPA soluble (D) and total RIPA
lysate (E) were probed with anti-GFP antibodies (N = 3). F, Densitometric analysis of total TDP-43:: GFP/Actin bands (from panel E) show an increase in TDP-43:: GFP in
response to 0.174 and 0.521 uM lead but an decrease in response to 4.69 pM lead. G, At 1.56 and 4.69 pM concentrations, lead significantly increases the ratio of insoluble
TDP-43:: GFP to soluble TDP-43:: GFP. N=3; mean * SEM; ANOVA w/Dunnett’s multiple comparison test, *p <.05, *p <.01. AU: arbitrary units. Predicted molecular

weight of TDP-43:: GFP ~70 kDa. Uninduced PC12 cells express no TDP-43:: GFP.

x = 1.65, £0.074 SEM, 0.521 pM Pb, x = 1.49, +0.193 SEM, p < .01).
At the highest concentration, 4.69 uM, lead treatments resulted
in significantly reduced TDP-43:: GFP (4.69 uM Pb, x = 0.57,
+0.054 SEM, p <.05), though this effect was coupled with sub-
stantial cell loss and may reflect death of high TDP-43:: GFP
expressing cells. Interestingly, exposure to lead robustly de-
creased the solubility of TDP-43:: GFP. At concentrations of
0.174, 0.521, and 1.56 pM a significant increase in the RIPA insol-
uble TDP-43:: GFP was detected (Supplementary Figure 6C).
However, at the lower doses of 0.174 and 0.521 pM, this may be
due in part to the increase in levels of total TDP-43:: GFP, as the
levels of RIPA soluble TDP-43:: GFP also increases at these lower
doses (Figure 3D). When the ratio of insoluble TDP-43:: GFP over
soluble TDP-43:: GFP is compared (Figure 3G), it reveals that ex-
posure to the higher doses of 1.56 and 4.69 uM lead triggers the
accumulation of insoluble TDP-43:: GFP (untreated, x = 1.00,
+0.140 SEM, 1.56 uM Pb, X = 2.06, £0.083 SEM, 4.69 uM Pb, x =
1.87, +0.179 SEM, p < .01). Insoluble TDP-43 pathology in ALS is
hyperphosphorylated with consistent phosphorylation of S409/
410 (Neumann et al., 2009). Using an antibody that detects
pS409/410 TDP-43 (Chew et al., 2015), we observed a significant
accumulation of insoluble phosphorylated TDP-43:: GFP in PC12
cells exposed to 1.56 and 4.69 pM lead (Supplementary Figs. 6B
and 6D).

Systemic Administration of Methyl Mercury Results in Accumulation
of Insoluble Tdp-43

We sought to study whether systemic exposure to methyl mer-
curic (1) chloride in vivo disrupted TDP-43 homeostasis in the
brain. 9-month old BALB/c mice were exposed to Oppm (no

treatment) or 5 ppm methyl mercuric (II) chloride in water pro-
vided ad libitum for 42 weeks (Shen et al., 2016). Solubility of
Tdp-43 in cortical tissue was assayed by biochemical fraction
methods previously used to detect insoluble TDP-43 in neurode-
generative disease (Neumann et al., 2006). Immunoblots of sar-
kosyl insoluble material shows that systemic exposure to 5 ppm
MeHg results in a>2.5-fold increase in insoluble monomeric
Tdp-43 (Figs. 4A and 4C; no treatment, x = 1.00, = 0.127 SEM,
5ppm MeHg, x = 2.52, +0.379 SEM, p <.05) and high molecular
weight Tdp-43 (Figure 4D; no treatment, X = 1.00, +=0.159 SEM,
5ppm MeHg, x = 3.21, =0.592 SEM, p <.05). In the total lysate,
Tdp-43 was slightly elevated at both the protein (Figure 4B,
Supplementary Figure 7A) and transcript level (Supplementary
Figure 7B), but this difference was only significant at the trend
level (p=.099 and .129, respectively). Similar to the effect ob-
served in primary neuronal cultures treated with lead, 5ppm
MeHg exposure resulted in a significant reduction in inclusion
of alternatively spliced exon 17b in cortical sortilin 1 transcripts
(Supplementary Figs. 7C-F). This data, together with that col-
lected from lead treatment of PC12 cells, provide strong evi-
dence that the heavy metals lead and methyl mercury trigger
accumulation of insoluble phosphorylated TDP-43.

DISCUSSION

Epidemiological studies suggest that environmental toxicants
including heavy metals (such as lead, mercury, and selenium)
are risk factors for ALS (reviewed in Trojsi et al., 2013), but the
mechanism underlying the risk is unknown. The sensitivity of
individual studies is sometimes confounded by difficulties in
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Figure 4. Methyl mercury exposure results in cortical accumulation of insoluble Tdp-43. Cortical tissue from mice exposed, by ingestion, to 0 ppm (no treatment, N =4)
and 5 ppm methyl mercuric (II) chloride (MeHg, N =7) was fractionated by solubility. The sarkosyl insoluble (A) and total lysate (B) (TE: Tris-EDTA) fractions were immu-
noblotted and probed for endogenous Tdp-43. Upon systemic MeHg exposure, sarkosyl insoluble Tdp-43 (C) and high molecular weight (HMW) Tdp-43 (D) is signifi-

cantly increased. Mean *+SEM; unpaired two-tailed t test, *p < .05. AU: arbitrary units.

correlating degree of metal exposure to disease onset and sever-
ity, which means meta-analyses can be more informative than
individual studies. Indeed, a meta-analysis of published works
estimated an odds of developing ALS to be 1.81 in individuals
with chronic occupational exposure to lead (odds ratio of 1.87
when reports of lead exposure are combined with reports of
heavy metal exposure) (Wang et al., 2014). Elevated levels of
heavy metals have been documented in the blood (Garzillo
et al., 2014) and CSF (Vinceti et al., 2013, 2017) of ALS-affected
patients. In ALS patient CSF, median 2°®Pb (lead) concentrations
were detected at 2.71 pg/l (or ~10 nM) and for >*°Hg (mercury) at
0.065 pg/l (or ~0.325 nM) (Roos et al., 2013) but troublingly, the
Center for Disease Control recognizes “blood lead level of con-
cern” at the higher level of >10 pg/dl (or 0.482 pM). These epide-
miological studies complement the current work, in which lead
(Pb) and methyl mercury (MeHg) were identified through a
blinded, unbiased screen of common toxicants and provides im-
portant support for the hypothesis that Pb and MeHg contribute
to the risk of ALS by acting as inducers of TDP-43 inclusions.
The ability to use high throughput screening to gain mechanis-
tic insights and identify putative toxicants for particular dis-
eases is incredibly important. This could be a valuable approach
to identify other neurodegenerative disease-causing toxicants
and the potential mechanisms of action of these toxicants.
Disruption of TDP-43 homeostasis, either increasing or de-
creasing its activity, is associated with motor neuron dysfunc-
tion (Lagier-Tourenne et al., 2010; Tsao et al., 2012). Decreased
nuclear TDP-43, which in disease occurs concurrently with
translocation and cytoplasmic aggregation, is classically associ-
ated with loss of splicing regulation. Studies show that the loss
of TDP-43 activity associated with increased aggregation is

deleterious, but point mutations in the C-terminus of TDP-43
that increase splicing-suppressive activity can also result in mo-
tor neuron loss and neuromuscular deficits (Fratta et al., 2018).
In the current study, we observe that heavy metals increased
formation of nuclear inclusions of TDP-43, increased total levels
of TDP-43 and increased TDP-43-mediated splicing activity,
thereby suppressing splicing events in the sortillin 1 (Sortl) gene.
Heavy metals also increased levels of aggregated TDP-43, which
is thought to be physiologically inactive but is strongly associ-
ated with neurodegeneration. Our results suggest that TDP-43
nuclear splicing activity is more sensitive to changes in total
TDP-43 levels than the accumulation of aggregated TDP-43. It is
important to note that changes in Sortl splicing activity in re-
sponse to heavy metal exposure could also reflect actions on
other nuclear components unrelated to TDP-43.

There is currently immense interest in the subject of LLPS
because it represents a novel mechanism of protein association
that appears to be of fundamental importance to the field of cell
biology (Li et al., 2018; Molliex et al., 2015; Shin and Brangwynne,
2017; Wang et al., 2018). Given this context, our observation that
lead increases LLPS of TDP-43 in vitro is particularly significant.
We hypothesize that toxic divalent metals increase TDP-43 olig-
omerization to effectively move TDP-43 along the phase separa-
tion curve into a region of increased droplet stability (nuclear
bodies) (Shin and Brangwynne, 2017). There is precedence for
perturbation of TDP-43 biology, as zinc binding to a segment of
TDP-43 corresponding to the RNA recognition motifs cause
TDP-43 to form aggregates in vitro (Garnier et al., 2017), and the
treatment of cultured mammalian cells with zinc triggers for-
mation of TDP-43 granules (Caragounis et al., 2010). Thus, other
heavy divalent metal cations (lead, mercury, tin, and selenium)



might induce TDP-43 dysfunction in a similar manner to zinc.
However, neither of the studies of zinc investigated LLPS. The
construction of many essential biological structures is achieved
through LLPS, such as the nucleolus, RNA granules, and the nu-
clear pore. As such, LLPS contributes to many critical cellular
functions, including RNA splicing, RNA transport, RNA transla-
tion, and ribosomal genesis (Shin and Brangwynne, 2017).
Hence, our observation that metals alter LLPS suggests a poten-
tially novel mechanism through which metal toxicants might
cause cellular dysfunction and human disease.

Many fundamental questions remain to be answered by fu-
ture studies. One key question is whether motor neurons are se-
lectively vulnerable to metal toxicants, as well as other
toxicants linked to ALS. The question of selective vulnerability
is key to the study of virtually every neurodegenerative disease
because most disease-related proteins are present throughout
the brain (and often throughout the body), yet the pathology
begins in a cell-type selective manner. The availability of
reagents such as induced pluripotent stem cells and single cell
sequencing are beginning to provide the tools that might an-
swer such questions of cell selectivity, but is beyond the scope
of the current study. Another important question is the rela-
tionship between LLPS and disease pathology. Some studies
suggest that insoluble aggregates, resembling those observed in
disease, can evolve directly from the phase separation process
(Molliex et al., 2015; Patel et al., 2015). A recent study suggests
that transient phase separation of TDP-43 protects against
disease-associated phosphorylation, but that under long-term
stress aggregates of phosphorylated TDP-43 form (McGurk et al.,
2018). We observe modulation of TDP-43 LLPS in vitro and cul-
tured neurons by exposure to metal toxicants and formation of
insoluble aggregates after extended exposure. This raises the
possibility that metal toxicants increase the risk of ALS by pro-
longing neuronal LLPS of TDP-43, with consequent disruption of
TDP-43 function and formation of insoluble aggregates.

The work presented here reveals that heavy metals trigger
formation of nuclear TDP-43 inclusions and perturb its RNA
metabolic functions. These results provide novel evidence of a
direct mechanistic connection between heavy metals, a com-
monly cited environmental risk of ALS, and molecular changes
in TDP-43, the primary pathological protein of ALS. This finding
warrants further study of the molecular mechanisms by which
heavy metals drive TDP-43 pathology and of the epidemiologi-
cal connection between heavy metal exposure and ALS. It also
supports the use of the inducible TDP-43:: GFP PC12 cell line as
an accurate platform for environmental toxicants and other
modifiers that play a role in the etiology of ALS and hence
should be considered as a part of a larger battery to screen for
neurotoxicants. These discoveries will provide further under-
standing of the disease mechanisms of ALS and deliver signifi-
cant benefits for public health.
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